
Thank you for your interest in TimeNet! Please take a few minutes familiarize yourself 
with its features by reading this comprehensive manual.
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I. Features

(•) Keep track of unlimited Clients
(•) Customizable Category rates
(•) Networkable
(•) Comprehensive visual reports
(•) Buzz Me! Reminder
(•) QuickTimer
(•) Project Archiving
(•) Client retainers
(•) View earnings as you work
(•) Expense tracker with auto-total
(•) Track miles and create reports
(•) Keep track of unlimited Tasks & Categories
(•) To-Do manager keeps you on task with auto-reminders
(•) File-linking locks a specific file to a task; start the task, the file opens
(•) 30 second auto-save prevents accidental data-loss
(•) Create professional invoices with your graphical letterhead
(•) Customize invoice font and design with invoice templates
(•) Invoice number management system
(•) Automatic rounding features for time spent and earnings
(•) Auto-update feature keeps your TimeNet up-to-date, always
(•) Invoice manager with extensive listing features
(•) Search feature for searching via name, invoice number, and other variables
(•) Support for foreign currency formats
(•) Tax features
(•) Auto-check for overdue invoices with late-fee options
(•) Address Book integration
(•) Project Notes feature keeps all project-specific notes close at hand.
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II. Using TimeNet

When you open the application, you are presented with your list of clients. Ex-
pand a client folder to see their projects. Use the Project and Client toolbar but-
tons to add new projects and clients.

TimeNet's Main Window
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11-A. Preferences
TimeNet's preferences are simple and straightforward. Here's a brief description 
of all the items you may customize in the Preferences window.

TimeNet's Preferences window
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 (•) Identity

 
 Establish your business here. Import your company letterhead logo, 

 
 and input all other relevant information about your business.

 (•) Options

 
 • Check for Update

 
 
 Makes TimeNet check for updates on open

 
 • Play Sounds

 
 
 Turn sounds on or off

 
 • Show Strobe while timing

 
 
 Turn the strobe graphic on or off

 
 • QuickTimer Pauses Other Timers

 
 
 Sets whether or not invoking the QuickTimer pauses other 


 
 
 running timers.

 
 • Pause All Timers When Idle For

 
 
 If you leave your computer, TimeNet can pause running 


 
 
 timers after a certain period of inactivity.

 
 • Currency Format

 
 
 Changes the currency symbol used in TimeNet

 
 • Invoices Must Be Paid Within

 
 
 Tells TimeNet how long you want to give clients to pay

 
 • Overdue Interest Rate

 
 
 When an invoice is overdue, TimeNet can mark up that 



 
 invoice by a percentage

 
 • Apply tax to invoice total

 
 
 Adds a tax percentage to your invoice

 
 • Round earnings to nearest xx

 
 
 Set to 25¢, $1, or don't round. If set to 25¢, $1.42 rounds up 

 
 
 to $1.50, and $1.79 would round down to $1.75. If set to $1, 

 
 
 $1.58 would round to $2, $1.29 would round down to $1.

 
 • Round time to nearest xx

 
 
 Set to hour, half hour, or 15 minutes to round your project's 


 
 task time respectively.

 (•) Charges

 
 Add charge rates in here. When timing your project, you'll assign 


 
 categories to the tasks you complete. Change the rate of pay in the 


 
 right column. Simply type in a number (i.e. 25) and TimeNet 
 


 
 formats it automatically.
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 (•) Invoice

 
 • Numbering

 
 
 Chose between sequential (counting up), or random invoice 


 
 numbering schematics

 
 • Templates

 
 
 This is your Invoice Template viewer. Double-click a template 

 
 
 name to view it and edit it in TextEdit. Option-double-click a 

 
 
 template to rename it. You may also jump to your Templates 


 
 
 folder with the pop-up menu.

Your invoice can be customized with information using "tags" to insert informa-
tion dynamically as the invoices are created. Simply enter the tag between <> 
symbols. For example: “Questions about this invoice? Call <my-phone>!”

Tags you can use:

Tag What it Inserts Tag What it Inserts

<my-name> Company’s Name <client-name> Client’s Name

<my-address> Address <client-address> Client’s Address

<my-address2> Address Line 2 <client-address2> Client’s Address 2

<my-city> City <client-city> Client’s City

<my-state> State <client-state> Client’s State

<my-zip> Zip <client-zip> Client’s Zip

<my-phone> Phone <client-phone> Client’s Phone

<my-email> Email <client-email> Client’s Email

<my-mobile> Mobile Phone <due-in> Invoice Due Days

<invoice-num> Invoice Number <invoice-total> Invoice Total

<markup-rate> Overdue Markup % <ex-total> Expenses Total

 Page 7



II-B. Main Window
TimeNet's Main Window keeps all of your clients organized via folders. All pro-
jects you create will be stored inside of the pertaining client folder.

TimeNet's main window organizes all clients and projects

Use contextual menus by Control-clicking or right-clicking on a client’s name 
or a project. You can quickly edit your client, email your client, show your cli-
ent’s phone number, generate a project invoice, and much more.

You can also Option-double-click a client to edit it.
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II-C. To-Do Task Center
TimeNet allows you to keep track of all deadlines via its To-Do Task Center. 
Double-click a task to open the linked project. If no project is linked, TimeNet 
opens the edit box. Click the edit button in the lower-right corner, or hold 
down Option while you double-click a task to force the edit box open.
         

           
TimeNet's To-Do Task Center
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Link tasks to projects and be notified if overdue

The Notify Me function is quite handy in that TimeNet will pop-up a notification 
when it opens if any items are overdue. You can set this to 0 to be notified on 
the due date itself.
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II-D. Manager
Use TimeNet's Manager to view all, paid, or unpaid projects. From there you can 
change whether or not they've been paid, or jump to the project to work on it 
further. TimeNet also allows you to jump to the final invoice for that project 
right from here.

TimeNet’s Manager also allows you archive or unarchive projects, as well as 
create comprehensive reports of the listed projects (see the reports section for 
more information).

Manager window
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Hold down the Option key and the Archive/Unarchive button will become Ar-
chive All or Unarchive All.

Control-click or right-click near the date fields to select a list of common time 
frames.

Control-Click or Right-Click to Auto-Fill Date Ranges
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II-E. Project Window
TimeNet's main functionality is in this window. Once you choose a client and 
click begin, you are presented with the Project window. In this window, you will 
add tasks, assign categories to them, and track your expenses. Once you have a 
categorized task, you may commence work. Let's see how this works.

      
TimeNet's Project window
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Get a fresh Project window open, and click the "+" button under the tasks box 
for New Task. Select the category of task in the popup menu. This sets the rate 
at which TimeNet will monitor your expenses earned. You may setup multiple 
categories with different rates in the preferences. For example, you may charge 
$50/HR for consultation, but only $35/HR for in-house work.

Once you click the "+" button, you're presented with the Add Task window.

Add a Task to your Project

Type in a brief description of the task, set the time you've spent on the task (if 
any), any notes that will help you complete the task, and a linked file (optional).

A linked file tells TimeNet which file you're working on for that task. Drag a file 
into the well and TimeNet will automatically launch that file when that task is 
started.

Now, you have a task and it has a category. You may Click the "Start Timer" 
button in the Toolbar. Inside the task box, the timer counts up. In the Project 
Information section, you can see the total project time, as well as the total 
earnings thus far. Feel free to add new tasks and test out the functions of 
TimeNet.

In addition to adding tasks and flat fee items, notice the "Add Discount" option 
at the bottom of the list. Choosing this will allow you to place a discount on 
your project, with a description, in either a percentage or a dollar amount.
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Notice the triangle and "Show Expenses" at the bottom-left of the window. Ex-
pand the triangle by clicking on it. Another box is shown.

      

TimeNet's Expense Tracker

Here, you can add all the expenses you may have incurred through the duration 
of this project. A total is automatically calculated at the bottom. Try it out: add, 
for example, "200 business cards" and give it a value of "$125.00". Now add 
"FedEx overnight CD delivery" at "$16.50". Keep adding more as you wish, and 
see how TimeNet totals everything for you.

You can stop your project and resume it at another time. The timesheet data is 
all backed up on file, and TimeNet automatically saves all project information 
every 5 minutes, as you work. This way if anything happens, your data is always 
current.

Another feature of the Project Window is the Notes function. Notice the right-
hand toolbar button called Notes. When you click this, a slide-out window with 
a text field is displayed. Here you can keep any notes you may want or need 
pertaining to that project. Very handy.

 Page 15



            
Project Notes slide-out
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II-F. Overdue Invoices
TimeNet will check all of your projects when it launches. It looks specifically at 
the finished date. If that date is older than the number of days you specified for 
late charges in your preferences, you get this window:

TimeNet’s Overdue Invoices Window

Check the invoices that should be processed. Uncheck an invoice to leave the 
markup off, for example if a payment arrangement has been made. You can 
completely dismiss this all together with the Remind Me Later button, or mark a 
project paid if you forgot to do so when payment was received.
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II-G. Invoice Window
TimeNet's main attraction is the ability to create professional and consistent in-
voices. Click the Create Invoice button in the Toolbar to see how this works.          

A TimeNet-Generated Invoice
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Feel free to edit your invoice as you wish in TextEdit. To save your invoice as a 
PDF file for emailing, simply choose File->Print and click the "Save As PDF..." 
button.

Also try re-creating your invoice with different templates, or design your own. 
See the Invoice Templates section for more information.
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II-H. Invoice Templates
TimeNet uses a template system for invoice layouts. Templates are created in 
Rich Text Format and may include tables, images, margins, or any other design 
element.

TimeNet comes bundled with four Invoice Templates. Open your Invoice Tem-
plates folder from your Preferences window in the popup under your Templates 
list (in your Invoices pane).

You may edit, delete, rename, or copy invoices here. When editing your tem-
plates, you will use tags to insert data into that template. Here is a list of tags 
you can insert:

Tag What it Inserts Tag What it Inserts

<my-name> Company’s Name <client-name> Client’s Name

<my-address> Address <client-address> Client’s Address

<my-address2> Address Line 2 <client-address2> Client’s Address 2

<my-city> City <client-city> Client’s City

<my-state> State <client-state> Client’s State

<my-zip> Zip <client-zip> Client’s Zip

<my-phone> Phone <client-phone> Client’s Phone

<my-email> Email <client-email> Client’s Email

<my-mobile> Mobile Phone <due-in> Invoice Due Days

<invoice-num> Invoice Number <invoice-total> Invoice Total

<markup-rate> Overdue Markup % <ex-total> Expenses Total

Notice how invoices are designed by checking out the included templates, and 
try playing around with your own designs. More templates will be available as 
more people design them, and you can submit your own designs by visiting our 
website.
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II-I. Reports
TimeNet has the ability to create robust visual reports in three different sec-
tions.

(•) Manager Reports

 Open your Invoice Manager and filter your projects using All, Paid, 
 


 Unpaid, Archived, and other parameters, as well as optionally filter with a 


 date range. Clicking the Report button ( ) will generate a report for the 


 filtered projects.

Manager Report

(•) Per Project

 See a report for a specific project by clicking the Report button ( ) in 


 your Project window.

 Page 21



(•) Per Client

 Client reports can be viewed by Control-clicking or right-clicking on a 


 client’s name in your Main Window. Client reports are excellent because 


 they also show you how much money you’ve made from that client com


 pared to your other clients.

Client Report
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From within each Report, you can copy the chart to the clipboard or print the 
chart (in full-screen glory), as well as drag it to your desktop or another appli-
cation to make a clipping or insert the graph into an application. For example, 
to insert a TimeNet-generated graph into this manual, all I had to do was drag 
it from my Report window to this document, and viola:
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II-J. Buzz Me!
A great feature of TimeNet is the Buzz Me! window. Select it from your Window 
menu, or hit Command-5. Use Buzz Me! to be reminded of an event in a num-
ber of minutes, or at a specific time.

BuzzMe! willy only notify you if TimeNet is still open, and won’t remember 
alarms if you quit and re-open TimeNet.

Buzz Me! Window
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II-K. QuickTimer
TimeNet’s QuickTimer feature lets you quickly start a timer at the press of a 
button (Command-2). Pause and resume the timer with the Spacebar, or by 
clicking the time field. When you are done, apply this to a project, or create a 
new project.

QuickTimer Window
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II-L. Mileage Reporter
Under the Window menu, you'll see the Mileage Reporter. If you've put any re-
cord of mileage into your projects, this is where you can create reports. You can 
see that it's easy to quickly view all or a date range. Just hit print and you're 
done.

TimeNet's Mileage Reporter
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II-M. The Menus

 (•) Application Menu

 
 • About TimeNet... - information about TimeNet

 
 • Register... - enter or order your TimeNet registration code

 
 • Check For Update... - Check for TimeNet Update

 
 • Preferences... - view and edit your TimeNet preferences

 
 • Provide TimeNet Feedback - goes to AppleSource feedback page

 (•) File Menu

 
 • New Project... - make a new project

 
 • New Client... - make a new client

 
 • Save Data - save the current project timesheet or invoice

 
 • Close - close the frontmost window

 
 • Work on Network/Local - toggle Network/Local Mode

 
 • Print... - prints the current item

 
 • Page Setup... - opens the printer configuration window

 
 • Backup - Reveals TimeNet Data folder

 (•) Edit Menu

 
 • All basic editing functions

 
 • Insert Short Date - Inserts the date in 00/00/00 format

 
 • Insert Long Date - Inserts the date in Sat, Oct 22 2005 format

 (•) Project Menu

 
 • Toggle Timer - starts or pauses the project timer

 
 • Create Invoice - generates an invoice

 
 • Round Project Time - perform time rounding based on 

 
 
 preferences set

 
 • Edit Late Fees - add or remove late fees for a project

 
 • Show Report - shows project report

 
 • Show Time Log - shows the log of tasks starting/stopping, etc

 (•) Window

 
 • Minimize - minimizes the current window

 
 • Zoom - expands the current window

 
 • Main Window - shows main client selection window

 
 • QuickTimer - shows the QuickTimer

 
 • To Do  - shows the To-Do Task Center

 
 • Invoice Manager - shows Invoice Manager window

 
 • Buzz Me! - shows the Buzz Me! window

 
 • Mileage Reporter - shows the Mileage Reporter window

 
 • The Window menu also shows all open windows
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II-N. Networking

TimeNet utilizes Apple's built-in File Sharing protocol to network. The beauty of 
this is that there is no extra software to buy, no configuration, no server-client 
software to buy. Each and every copy of TimeNet 2.7 and above has this net-
working goodness built right in.

Getting Connected
1. Pick a computer that has TimeNet data on it. This will be the "host" as it will 
contain all TimeNet data and serve it to connected copies of TimeNet.

2. Turn File Sharing on for that Mac (refer to your MacOS X User's Manual) and 
connect to (mount) that computer from all other computers running TimeNet.

Mount the Hard Drive with TimeNet's Data folder
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3. On any computer with the "host" mounted, run TimeNet and choose File-
Work on Network (Apple+K). TimeNet will tell you there's no network specified. 
Click okay, click the mounted "host" hard drive, and navigate to the TimeNet 
Data folder:

Hard Drive:Users:Main User:Library:Preferences:TimeNet Data

TimeNet will then go into Networked mode and all clients and and projects will 
be listed from the "Host". Any changes you made will be visible to the "Host" 
and any other TimeNet copies connected to that "Host".

TimeNet will then remember the location of your served Data folder, so to run 
in Networked mode again, simply be sure that the hard drive is mounted and 
you're good to go.

Chose File-Work Locally (Apple+K) to return to working locally, where you may 
have different clients and only you can see the changes you've made.
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111. How To Contact Us

If you have an idea for a new feature, or have found a bug, or just have a ques-
tion regarding TimeNet, we'd love to hear from you. Here's how to get in touch 
with us:

Use our web form online:
http://www.applesource.biz/software/timenet/feedback.html
Email us directly:
support@applesource.biz
Visit our support site:
http://www.applesource.biz/support.html

For more information on TimeNet, what's up in the next versions, and a pro-
gress report on development, check out the TimeNet Developer's Journal at our 
online software forum:
http://www.applesource.biz/supportboard
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1111. Purchasing TimeNet

Order online via credit card:
http://www.applesource.biz/order/

PayPal is our authorized online payment handler. You will be making credit card payments through them

Send a check or money order for $48:

Perry Fjellman
c/o AppleSource
1999 Woodside Dr
Medford, OR
97501

Make all checks or money orders payable to "Perry Fjellman" Once you've sent 
it, email support@applesource.biz with the check or money order number. 
When we receive the money, we'll email you a registration code.

We offer substantial discounts for multiple license purchases. Contact 
sales@applesource.biz with the your order and we'll give you a bulk license dis-
count.
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Appendix A. Credits
TimeNet was written by Perry Fjellman of AppleSource. It couldn't have been 
done without the help of the following people:


 • Chris Molé

 
 TimeNet was originally a custom application written for Chris. 


 
 The project grew from there. It was by her good graces that Chris 


 
 allowed me to continue to further improve upon TimeNet and 


 
 release it to the world, keeping many of her wonderful features and 

 
 ideas
 intact. If it wasn't for Chris Molé, TimeNet wouldn't be.

 • Peter Monroe

 
 Peter has been a solid player in the AppleSource role for a few 


 
 months now. It was he who introduced Chris Molé to our software 


 
 design services, and has been a strong source of encouragement.

 • Samantha Lynn

 
 The lovely and beautiful Samantha supplied encouraging words and 

 
 wonderful ideas, as well as being a terrific beta tester. She also 


 
 leant a hand with her vocal talents on the video demonstrations.

 • All of our beta testers!

 
 Kris Parker

 
 Chris Molé
 


 
 Samantha Lynn

 
 Jeannie Chapman

 
 Linda Barnes

 
 Peter Monroe

 
 Nate Brown
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Appendix B. Legalities

Initial Information
 - TimeNet is distributed "as is", and offers no warranties. The author of this software (Perry 
Fjellman) takes no responsibility for any damage, coincidental or not, that may be caused by the 
use or misuse of this product. It wasn’t created to crash your computer, make your monitor 
smoke, make the washer spew soap suds, or turn your dog on you. But, as we all know, due to 
the unpredictability of computers, anything's possible.

Distribution
 - TimeNet is a shareware product. The demo may be given to a friend, a coworker, or the man 
at the bagel shop, freely, provided that all of the documentation is included. We at AppleSource 
put a lot of trust into our users. Because of that, we ask you to comply with our requests and 
not steal this software. The TimeNet Demo can be included on a CD, provided you E-Mail us 
with the publication information, and the above requests are met.

More information to read only if you're extremely bored
 - This software may not be modified, copied, or mangled for any reason. You may not modify 
this, or any other document included with this software package. Before you may use TimeNet, 
you must agree to the terms herein.

© 2005 AppleSource - We Open Doors, Not Windows
Written by Perry Fjellman

http://www.applesource.us/
perry@applesource.us

--

http://www.applesource.biz/
http://www.applesource.biz/software/timenet
support@applesource.biz
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